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Summary of Changes

This revision of the user’s guide contains the following changes to the 
district integration process.

Page Number Change

14 Added a note in the "Automated TaskServer 
Operations" section. 

15 Added the "TaskServer Configuration for Macintosh" 
section. 

64–65 Revised the "Troubleshooting the Upload Process" 
section. 

66–67 Added the "Troubleshooting the Download Process" 
section. 



viii   Copyright © 2005 Pearson School Systems

Summary of Changes



Copyright © 2005 Pearson School Systems  1

Description

This guide describes the process of planning, implementing, configuring, 
verifying, and using the District Apps module of the SASIxp™ educational 
software made available by Pearson School Systems.
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Description

Prerequisites
Pearson School Systems recommends having these skills and knowledge 
sets for the proper use and understanding of this guide:

! Installation, configuration, and operation of the SASIxp™ software.
! Network Administration operations of the LAN/WAN environment 

where you plan to implement the SASIxp District Integration software.
! TCP/IP networking protocol installation and configuration operations of 

the LAN/WAN environment where you plan to implement SASIxp 
District Integration.

! Configuration and Operation of desktop operating systems and 
Graphical User Interfaces (GUIs) necessary to the environment where 
you plan to implement SASIxp District Integration. 

Instructional Objectives
1. Contrast the operational differences between the two standard 

configurations of a single-school SASIxp installation.

2. Define these parts of the SASIxp District Integration software:

! Features and benefits of SASIxp District Integration
! Basic District Integration Theories of Operation
! Product Requirements

3. Perform District Integration installation tasks.

4. Address data installation and conversion issues.

5. Perform District Integration configuration and setup tasks.

6. Perform District Integration operation and user tasks.

7. Set up and operate District Consolidation.

Scope
This guide addresses the District Integration implementation of the SASIxp 
software. This reference manual is for those individuals who are 
implementing the District Integration operation of the SASIxp software. 
Knowledge of basic SASIxp operations is necessary to understand and 
use this training guide effectively.
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Description

The manual contains:

! Topic 1, Description. This topic describes the concepts and 
requirements of the District Integration implementation of the SASIxp 
software.

! Topic 2, Using District Integration. This topic provides an explanation of 
the District Integration interactive and automated operations.

! Topic 3, District Consolidation. This topic provides a description of how 
to set up and use the District Consolidation feature.

In addition, this document contains this appendix:

! Appendix A, Troubleshooting. This appendix provides information on 
possible errors you may encounter when using the SASIxp District 
Integration.

District Integration Overview
The District Integration (DI) module expands on the basic SASIxp 
software’s functionality to provide centralized district processing between 
the schools and the district office using a Wide Area Network (WAN.) 
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Description

Implementation

One of the most significant features of District Integration is the ability to 
add, drop, and transfer students in real time. A district file is a form of the 
standard SASIxp school database, which incorporates student data from 
all schools within the DI environment. 

District Integration also provides for scheduled background operations to 
upload student data files from school sites to the district office and update 
the district file on a nightly basis. In addition, District Integration provides 
the ability to download certain files to the school sites.
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Description

Because you can replicate data at the district office on a nightly basis, the 
district office staff can view an individual school’s files. District office staff 
no longer log into a school site file server to view school data. District office 
staff can run reports against copies of the individual school site files 
residing on the district file server. They can also run reports against 
consolidated data in the district file.

District Integration is a normal SASIxp installation at the district office with 
some configuration changes and additional directory creations.

District Integration also requires the addition of a specialized type of 
workstation. This workstation is dedicated to running one of the major 
programs of the SASIxp DI module and resides at the district office. This 
workstation runs the SASIxp TaskServer program that performs the core 
DI communication operations.

TaskServer runs 24 hours a day on one or more workstations at the central 
office. Pearson School Systems recommends a minimum of one 
TaskServer workstation for every 10 school sites. The TaskServer 
workstations run on either the Windows NT® Workstation version 4.0-SP4 
operating system or the Macintosh System 7.5 operating system. For 
performance reasons Pearson School Systems recommends running the 
TaskServer program only on the Windows NT 4.0-SP3 Workstation 
operating system.

TaskServer supports these database scenarios:

It is possible to run multiple TaskServers on one workstation, if appropriate 
for your installation.

Note: The configuration changes are also necessary at each of the 
school site SASIxp installations.

District School Site

dBASE IV dBASE IV

Oracle dBASE IV

Oracle Oracle

MS SQL dBASE IV

MS SQL MS SQL
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Description

DI Real Time Operations

Uploading requires the TaskServer to use a valid user account on a 
supported SASIxp site server, and access rights to the resource containing 
the school data.

Operation Description

Add, Drop, and Transfer The Enrollment atom running at the school 
site communicates with TaskServer at the 
central office. Together the Enrollment atom 
and the TaskServer program immediately 
upload and download student information 
between the school site and central office to 
add, drop, and transfer students throughout a 
district.
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Description

Scheduled Background Operations

Operation Description

Upload At the end of the school day, the TaskServer 
logs into the school site servers to upload 
data files to the central office. This data can 
be either all qualified site files or only those 
qualified site files that have changed from the 
previous upload process. 

During this process, the SASIxp software 
stores the file you select to copy in the 
Upload folder of the district SASIxp 
installation directory structure. 

In this process, the data for all students 
copies from the school sites to the central 
office. 

Download In this process, selected files download to 
school sites automatically.
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Description

Overnight Update

Overnight Updates require the TaskServer to use a valid user drivemap on 
the District server and access rights to the resource containing the District 
data.

Operation Description

Overnight Update After the files copy from the school sites each 
night in the Upload process, the TaskServer 
creates a mirror copy of all DI school site 
qualified files. It then updates the central 
office student demographic file with new 
demographic data from the school sites. 

Note: When it finishes this function, the 
TaskServer program returns to add, 
drop, and transfer mode.
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Using District Integration 

This topic provides an overview of the TaskServer and Student enrollment 
operational tasks for the DI implementation of the SASIxp software.
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TaskServer Operation
The TaskServer program enables school sites to perform add, drop, and 
transfer enrollment operations and immediately update the district file 
during the day. Also, the TaskServer program automatically uploads 
school site student data files and updates the district file. With this 
program you can also download specific files to school sites.

After setting up the TaskServer, all tasks perform automatically. 

In a multiple TaskServer environment, all TaskServer workstations perform 
the upload portion of the nightly automated processes. Only the primary 
TaskServer performs the Update District Student File and Download tasks.

TaskServer Overview

The TaskServer program uses these menus:

Menu Description

File Menu Use the File menu to:

! Save the Status and Errors windows as 
text files

! Set up the page layout of the automatic 
TaskServer reports

! Quit the TaskServer program

Edit Menu Not available.

Tasks Menu Use the Tasks menu to:

! Perform real-time enrollment operations 
! Perform school Site Upload operations
! Perform update operations
! Download selected files 
! Terminate the running operation

Windows Menu Use the Windows menu to display the status 
of tasks, and any errors. You can enable 
operational messages by selecting the 
Debug mode option.
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Windows Menu Functions

The Windows menu includes options for displaying the status of tasks and 
errors that occur during the performance of tasks.

Tasks Menu Functions

The Tasks menu includes these options:

! Upload Remote Sites
! Update District Student File (ADST)
! Download to Remote Sites
! Abort Current task

Pearson School Systems recommends performing the Upload, Update, 
and Download functions after hours. After enabling the real-time 
operations, the TaskServer program automatically switches between real-

Help Menu The Help menu provides the About option. 
Selecting this option displays the About 
TaskServer window, which displays Task-
Server product information.

Menu Description

Function Description

Show (Hide) Status Displays the Status window, which shows 
status of actions taken by the TaskServer 
during the performance of a task.

Show (Hide) Errors Displays the Errors window, which shows 
error information from the TaskServer during 
the task performance.

Cascade, Tile, Arrange Controls the view in which the Status and 
Errors window displays within the main 
TaskServer window.

Debug Mode Displays detailed information about tasks in 
the Status and Errors windows. 
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time and automated background operations. The Tasks menu permits 
switching between tasks to permit on-demand, manual execution of the 
background processes.

Function Description

Transfer Students Enables real-time enrollment operations 
within the DI implementation. All TaskServer 
workstations must initiate this option for 
District-wide enrollment operations to work 
properly. When in the Transfer mode, the 
TaskServer automatically switches into 
Upload and Update modes. After completion 
of the Upload and Update operations, the 
TaskServer returns to Transfer mode.

Upload Remote Sites Permits scheduled or immediate execution of 
the Upload process. Selection of this option 
disables real-time operations of the 
TaskServer. 

Update District Student 
File (ADST)

Permits scheduled or immediate execution of 
the update process. Selection of this option 
disables real-time operations of the 
TaskServer.

Download to Remote 
Sites

Downloads the files listed in AFLD to the 
school sites.

Abort Current Task Stops the current operation.
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TASKSERV.ini File

The TaskServer can open other applications by creating a TASKSERV.ini 
file. Use the Note Pad application to create the file. You can specify 
whether the application is to run before a download, after the download, or 
before updating the district file. External processes can be any valid 
executable program, that runs in batch mode without operator intervention.

TASKSERSV.ini file example:

*****************************************************************

;This file should be in the same directory as TaskServer
; application

;List the applications that will be launched by this TaskServer
[ExternalApps]
App1 = UpdateSomeFile ;
App2 = ExportASTU;

;Details about each of the above mentioned applications
[UpdateSomeFIle]
Name = UpdateFile.exe ;name of the application
WaitTillAppDone = TRUE ;should the TS wait until app is done
Parm = file = ATBL ;information to be passed to app as a parm
SupplyLoginInfo = FALSE ;should SASIxp user ID and Pwd be passed to app

; as first two parms
LaunchWhen = BeforeDownload ;can be BeforeUpdateDst, BeforeDownload,

; AfterDownload; BeforeUpload

[ExportASTU]
Name = ImpExp.Exe ;name of the application
WaitTillAppDone = TRUE ;should TS wait until app is done
Parm = group=ExportASTUMap ;any information to be passed to app as a parm
SupplyLogoInfo = TRUE ;should SASIxp user ID and Pwd be passed

; to app as first two parms
LaunchWhen = AfterDOwnload ;can be BeforeUpdateDST, BeforeDownload,

; AfterDownload
*****************************************************************

Automated TaskServer Operations

Transfer mode operation is necessary for school sites to perform real-time 
enrollment operations. 

At the Upload time for a particular campus in the District Site Campus 
atom configuration, the TaskServer automatically switches to the Upload 
Remote Sites operation. This operation begins uploading the data files 
from the campus file servers to the Upload directory. 

Note: In the [ExternalApps] section, the labels need to be sequential.
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The primary TaskServer workstation waits until the Overnight Start Time to 
begin the overnight processing. 

However, if any of the TaskServers do not complete the upload process by 
the start time, uploading continues until the process completes. Then the 
Update process initiates.

During upload processing, all files upload to upload folders. When all sites 
complete, each TaskServer moves the data to the District datafile.

The TaskServer then returns to the real-time Transfer mode of operation.

Note: Assign the Overnight Start Time in the District Control atom.

Note: After the TaskServer program begins either the Upload or Update 
process, it does not accept any add, drop, or transfer requests.

Note: The TaskServer creates the TS<nnn>_<yyyymmdd>Status.log 
and TS<nnn>_<yyyymmdd>Error.log, where <nnn> specifies the 
TaskServer ID and <yyyymmdd> specifies the date for status and error 
messages respectively. These files are deleted after fifteen days.
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TaskServer Configuration for Macintosh

Before installing TaskServer on a Macintosh workstation, do the following:

! Set the ApplicationInHomePath entry to False in the SASIxp.ini file.
! Ensure that the TaskServer folder on a Mac OS 9 computer contains 

TaskServer, license.ini, sasixp.ini, and CSClassicLib files.
! Map the TaskServer to the parent folder of the school server’s SASIxp 

folder. The name of the parent folder is not critical as it is not 
referenced in any of the .ini files. The school server and the 
TaskServer must be on separate computers. The TaskServer can 
access the school server only through a mapped or mounted drive.

! When you install TaskServer for a Macintosh workstation, define an 
AppleTalk  zone before the Remote Site Data Path in the Campus 
Setup atom. If you do not define a zone you need to place an asterisk 
before the path. For example, 
*:192.168.100.100:sharepoint:SASIxp:Datafile:
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Enrollment Operations
During the day, the TaskServer performs the Transfer Student task. The 
TaskServer is continually accepting Add and Transfer requests from 
schools, and immediately updating the District file on the district file server. 

Use the Enrollment atom to:

! Add new students as they enroll during the course of the year.
! Inactivate students when they leave.
! Reactivate them if they re-enroll.
! Transfer students from one school to another within the district.

Adding New Students

1. At a school site, open the Enrollment atom. The District Enrollment 
screen displays. 

2. From the Data pull-down menu, select Add Student. 

3. The District Enrollment window displays.

4. Enter the student's last and first name. 

Note: If you get a message indicating communication with the 
district could not be established, do not proceed with the Enrollment 
of the student. Contact the district office and report the problem.
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5. Click Find. The SASIxp software searches for the student record in the 
District file. A list of similar students display. Scroll through the list to 
verify the student does not exist in the District database.

6. After verifying the student does not exist in the District database, click 
Add. When adding a new student and using the automatic assignment 
of Student ID’s, the Student ID field displays asterisks in the place of 
student’s ID in the District screen. After you click Save, the system 
assigns a Student ID.

7. After adding or transferring the student, the Enrollment screen 
displays. Use this screen to enter the following information:

! Address
! Phone Number
! Parent/Guardian
! Grade

8. Click Save. 

Note: If the student is in the database, highlight the student’s name 
and click Transfer, and the student and all of their information 
transfers to your school database.

Note: Be sure to make any Grade changes in this window. If not, 
the Grade could be recorded incorrectly in the District file.
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9. Use the Fast Access arrows to complete the Enrollment of the student 
into your school.

Inactivating Students

1. At a school site, start the Enrollment atom from the Student Info folder.

2. Click the Find icon.

3. Enter the student’s name to inactivate, and click Find.

4. After finding the record, select Inactivate Student from the Data pull-
down menu. 

5. If necessary, modify the Leave Code and Leave Date.

6. Click Save. 

The following occurs after inactivating a student:

! The Student file at the school performing the operation updates with 
the leave date and leave code from the Current screen of the 
Enrollment atom.

! The enrollment mirror file residing at the district updates with the same 
information from the school site enrollment file.

! The Status screen of the District atom updates with the leave date and 
leave code from the Current screen of the Enrollment atom at the 
school performing the inactivate request.

! All files and update immediately. 
! Inactivating a student changes the student’s status to Inactive.
! After inactivating a student, all sub-files are sent to the district office.

Note: See the Enrollment section in the Basic Applications User 
Guide for more information on enrolling a student.

Note: If the student is transferring to another school on the current day, 
adjust the leave date according to the student’s last day of attendance 
at the school of the Inactivate operation. If this is not done, the student’s 
next school of attendance cannot use the current date to activate the 
student.
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Transferring Inactive Students

Use this procedure to transfer students who are currently inactive but were 
enrolled at a prior time.

1. Open the Enrollment atom. 

2. From the Data pull-down menu, select Add Student. The system 
displays the District Enrollment option.

3. Enter the student's last name and first name.

4. Click Find.

5. After locating the student to transfer, double-click on the student name 
and the Enrollment screen displays. 

6. Click Save.

7. Click Close.

Possible Transfer Date Conflict

If the SASIxp software displays the message, ERROR: Enter date is less 
than the latest district transaction date for this student, complete these 
steps:

1. Click OK.

2. Click Cancel.

3. Change the Enter Date to a date later than the last district transaction 
date.

Note: Inactive student names display in bold type.
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Using the Transfer Course History Atom
The Transfer Course History Atom enables you to transfer course history 
records from concurrent schools to home schools. Use a batch process at 
the District on the mirror files, or transfer data for a group of students at a 
site, using the TaskServer in Transfer mode.

Transfer CHS Screen

The Transfer CHS screen contents depend on your selection in the Select 
where you are running from section at the top of the screen.

Transfer Course History Fields

Use the Select where you are running from section to identify where you 
run the transfer course history process:

Field Description

District Uses district mirror files. Displays the 
Concurrent Schools and Home Schools 
matrixes for selecting schools.

Site Uses the TaskServer. Displays the Student 
matrix for selecting students.
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Fields for District Processing

The Concurrent School’s matrix displays the school number and name of 
the concurrent school.

The Home School’s matrix displays the school number and name of the 
home school.

Field Description

Year Year containing the data to transfer from the 
concurrent schools. SASIxp file system 
allows retention for up to ten years of data on 
your machine. The year is determined by the 
fifth character of the file name. For example, 
the student file for school 999 for the year 
2005 would be ASTU+5+999 or ASTU5999. 
But, if you have not created a datafile for the 
year 2005 and have the datafile for the year 
1995 on your machine, then the data from 
1995 will be presented for the year 2005.

Field Description

Year Year to transfer data to the home schools. 
SASIxp file system allows retention for up to 
ten years of data on your machine. The year 
is determined by the fifth character of the file 
name. For example, the student file for 
school 999 for the year 2005 would be 
ASTU+5+999 or ASTU5999. But, if you have 
not created a datafile for the year 2005 and 
have the datafile for the year 1995 on your 
machine, then the data from 1995 will be 
presented for the year 2005.
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Select Schools Screen

The Select Schools screen contains a double matrix. The left side contains 
the available selections. The right side contains the items you select.
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Select Schools Fields

Transferring Course History Data at the District

Transfer course history data from concurrent schools to home schools 
using the District mirror files.

1. Open the Transfer Course History atom.

2. Select District from the Select where you are running from selection.

3. Click the Select Schools Fast Access atom under the Concurrent 
Schools matrix to select the concurrent schools for the source of the 
course history data. 

4. Select the year containing the data to transfer.

5. Click the Select Schools Fast Access atom under the Home Schools 
matrix to select the home schools to update the course history data. 

6. Select the year to update.

7. Click Process.

Field Description

Locate Field to quickly find the school to select. 

Available selections List of the school names available for 
selection. 

Selections Selected schools from the Available 
Selections list. The maximum number of 
selections is 20 schools.
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Transfer CHS Screen

Transfer course history data from concurrent schools to home schools 
from any school site, using the TaskServer. This process updates data at 
all schools the student is concurrently enrolled in.

Transfer CHS Field

The Student matrix displays the student ID and name of the selected 
students.

Note: To successfully transfer course history data from a site, connect 
to the District using the TaskServer. Verify the TaskServer is in Transfer 
mode. Upload the ACHS files so the mirror files reflect the site. Also, 
update the ADST file.

Field Description

Year Year containing the data to transfer for the 
selected students.
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Transferring Course History Records at the District

1. Open the Transfer Course History atom.

2. Select Site from the Select where you are running from section.

3. Click the Select Schools Fast Access arrow under the Student matrix 
to select the student records to transfer. 

4. Select the year containing the data to transfer.

5. Click Process.

Adding Students Concurrently

Concurrent enrollment is when a student enrolls at more than one school 
at a time. With District Integration, the District sets up specific schools to 
accept the transfer of active students for concurrent enrollment. When the 
transfer is complete, the Student file and sub-files download to the 
concurrent enrollment school from the District. The student now has two 
active records in two separate locations.

1. At a school site, open the Enrollment atom. 

2. On the Current screen, select Add Student from the Data pull-down 
menu. The District Enrollment window displays.

3. Enter the student's last and first name.

4. Click Find.

5. After locating the student record, double-click the student name in the 
matrix. A status messages displays as the District file is read.

6. If the student is currently active and the Enrolling School is set up to 
permit concurrent enrollment, the following message displays:

Do you want to concurrently enroll student Student’s
Name who is already active at home school: School
Number - School Name?”

7. Click OK.

8. After selecting a student, the Enrollment window displays for final 
verification of the student. 

9. Click Save.
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Notes on Concurrent Enrollment

! Students must be currently active to perform concurrent enrollment.
! Perform concurrent transfers in the same way as transfers for inactive 

students with the following exception: A history line does not 
automatically generate for the transfer in the History matrix, because 
the student is still enrolled at the home school. Instead, the SASIxp 
software creates a concurrent enrollment transaction to track the 
effective dates of the concurrent enrollment at the District office. 

Centrally Enrolling Students

The central enrollment process enables a school district to control 
enrollment of students by channeling all students through a central 
enrollment school. Options include the following:

! Add all students to the Central Enrollment School at the District, and 
assign them to individual school sites. The school sites transfer the 
students out of the Central Enrollment School into the site school.

! Set up a school site to limit the transfers of students to those who are 
already assigned.

! Set up a school site to transfer all students in the Central Enrollment 
School. 

! Set up school sites to prohibit the adding of new students or from 
adding a student to the Central Enrollment school. Perform this setup 
in the District Control atom. 

Perform the operation of adding and transferring student records in the 
same manner as a school site. The difference is only district office 
personnel can add students to the Central Enrollment School and the 
Central Enrollment School exists in the SASIxp software installation at the 
district.
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Deleting Records 

The two function for deleting students are to undo a bad transfer, or to 
actually delete a student. 

Delete student records only for troubleshooting purposes. If removing a 
student, perform a No Show or the Inactivate operation from the 
Enrollment atom. 

1. At the School Site, open the Enrollment atom. 

2. Click the Find icon.

3. Enter the student’s name.

4. Click Find. 

5. From the Data pull-down menu, select Delete Student. 

6. Click Save. 

Cross-Year Enrollment

Cross-Year Enrollment enables you to transfer a student from a previous 
year.

Adding Students Using Cross-Year Enrollment

1. Open the Enrollment atom.

2. From the Data pull-down menu, select Add Student. 

3. Select the year from the Transfer from Year drop-down.

Note: After deleting a student, the SASIxp software immediately:

! Deletes the student record from the school site file.
! Deletes the student record from the school site mirror file at the 

District.
! Deletes the student record from the District file.

Note: Course history may not update because you can enroll an active 
student. Running Update Course History for the active student in the 
school/year to ensures your course history is complete.
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4. Select Find.

5. Select the student to transfer, and click Transfer.

6. After the student transfers, the student record displays.

7. If necessary, edit the student record.

8. Click Save.

9. Repeat these procedures to add all cross-year enrollment records.

10. After entering all cross-year records, click Close.

Working with the District File (ADST)
District Integration provides District Office staff members with a 
consolidated District-wide view of student information through the District 
file (ADST). District Office staff use the District atom to interact with the 
District file and extract information available for each student at each 
school in the District. 

Use the District atom to view the sub-demographic data for each student’s 
records in the District file. This information updates on a nightly basis 
during the update process. Do not make changes to the District File 
(ADST) at the District. Any changes made at the District will be overwritten 
during the update process.

When the nightly upload process runs, the ADST file is locked and not 
available for use.

Note: When selecting Find, a list of students available for transfer 
from the selected year displays. Eligible students for transfer 
display as normal text in the Student list. Students who are not 
eligible for transfer are dimmed. If there are no files for the specified 
year, a warning message displays, and you need to select another 
year.
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Use the District atom to print the One Per Family Labels and the District 
Alpha Directory reports. Select a report from the District pull-down menu. 
The Report Interface for the report displays. Use this interface to run either 
the Generic version of the report or a user-definable Custom report. All 
reports contain the available data from the current date.

Report Description

One Per Family Labels Produces address labels for mailing to 
parents, based on the family number. The 
SASIxp software automatically assigns the 
family number when using the Sibling atom to 
copy data from one sibling to another. Labels 
print two or three across in alphabetical 
order, depending upon the label type you 
select.

Note: The Sibling atom does not work across 
schools.

District Alpha 
Directory

Produces a directory list of the students 
enrolled at each school in the district. This 
report is organized first by school, then by 
student.
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Status Info Tab

The Status Info tab provides District Office staff members with the student 
status history. The information is the last school of residence in each 
school year. Up to ten years of information displays. If the student is 
currently active, the leave date and leave code are blank.

Status Info Fields

Note: To verify the student’s information on the Status Info screen and 
to update and force a search the mirror file, press the Ctrl key and click 
the Link field. 

Field Description

Year Years of student attendance history.

School Name of the student’s last active school for 
the year.

Grade District grade level of the student for the year.

Leave Date Date the student left the school for the year.
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DI Inspector
The DI Inspector atom enables you to monitor and fix synchronization 
issues between the site, mirror, and district files. This atom helps you 
maintain District Integration.

District Integration requires the site, mirror, and district database files be 
synchronized to function correctly. The DI Inspector atom produces reports 
of existing inconsistencies between database tables, and it provides tools 
for fixing discrepancies. 

The DI Inspector screen has these tabs:

! Log Viewer
! Check ENR
! Overnight Test
! Check ATRN

Leave Code Code the SASIxp software uses to identify 
the reason the student left the school.

Link Student link number for this student for the 
school year for each record line.

Field Description



32  DI Inspector Copyright © 2005 Pearson School Systems

Using District Integration

Log Viewer Tab

The Log Viewer tab enables you to view the contents of seven different log 
files created by TaskServer activities.

Top Buttons

Lists names of files and will give a description of what the file contains.

Trimming Actions

The trimming action buttons display at the bottom of the screen. The 
trimming actions are cumulative. First hide older records, then hide 
matching records to further reduce the number of records to display, or 
delete records from the file by using the Trim Log button.

Button Description

Hide Older Hides all records with a later date than the 
entry you select.

Hide Newer Hides all records with a more recent date 
than the entry you select.
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Trimming Log Files

1. Select the file to trim by selecting the file’s button.

2. Select the most recent record to keep.

3. Click Trim Log.

4. The system displays a message to trim the file you select. Click Yes.

Check ENR Tab

The Check ENR tab on the DI Inspector atom opens the district mirror 
ASTU and AENR files for each school and looks for perm number and 
enrollment consistency errors. The SASIxp software checks each ASTU 
and AENR record against the corresponding District Student (ADST) and 
Enrollment (AENR) records. 

Hide Matching Hides all records in the matrix with matches 
on the field you select.

Show Matching Shows all records in the matrix with matches 
on the field. It hides all non-matching records.

Show All Cancels all filtering and allows the refinement 
process to restart. Resets the matrix to the 
original display, which undoes all of the 
previous button changes, except for Trim 
Log.

Trim Log Permanently deletes fields in the log that are 
earlier than the record you select.

Note: Verify you have selected the correct record before clicking 
Yes. There is no way to undo the trim.

Button Description
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The system verifies the enrollment status information matches and 
ensures the perm numbers are unique. When non-matching enrollment 
status information is found, an error is written to the text log file, 
DIInspect.log.

Possible enrollment errors are:

! A student is recorded as active in multiple schools.
! A student has inconsistent enrollment information.
! A student has a leave date but no enter date. 

All errors involving enrollment records display in the matrix on this tab. 

Another log file, DISortResults.log, contains the results if selecting any of 
the Show Students... checkboxes.

Note: To print the log file use the Export List atom, and save the log file 
as a .txt file. Open or print the file using Wordpad.
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Overnight Test Tab

The Overnight Test tab of the DI Inspector atom performs a check of the 
District settings and reports any possible errors in a text log file, 
DIITest.log.

After Executing the Overnight Test the SASIxp software displays the 
following messages:

While the test is running you will be unable to make
enrollment changes at the district. Proceed with test?

This test may take several minutes for the TaskServer
to run. Please wait.

Field Description

Check Enrollment 
History

Starts the process of checking the enrollment 
history.

Add Missing AENR 
Records

Adds missing records to the AENR file. If 
inconsistencies are found in the enrollment 
history for a student across schools, the 
appropriate updates are made to the AENR 
files.

Show students with 
same perm num

Examines mirror files to find two students 
with the same perm number. The error log 
displays students’ names, perm nums, and 
whether the students are concurrently 
enrolled in another school.

Show students with 
same last name/
birthdate

Examines mirror files to find two students 
with the same last name and birthdate. The 
error log displays the students’ names, perm 
nums, birthdates, and whether the students 
are concurrently enrolled in another school.

Show students with 
same last name/first 
name

Examines mirror files to find two students 
with the same first and last names. The error 
log displays the students’ names, perm 
nums, and whether the students are 
concurrently enrolled in another school.
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Click OK to continue the test.

The Overnight Test simulates a nightly upload/download process for each 
school by completing the following:

! Mounts the school server.
! Downloads a test file to the school.
! Uploads the same test file to the District server.

It examines the start times in the District Control (ADCL) and Campus 
Setup (ACAM) files, and reports the sequence for the campus uploads. 

It also records configuration errors, which include the following:

! File included as sub-files for transfer but not in the nightly upload.
! Data source names in ACAM, which are not enclosed in square 

brackets, but match one of the bracketed data source parameter 
groups in the RDBMS.ini file.

! Site and District server using the same SQL data source.
! Schedules the Upload start time in the late morning rather than in late 

evening.
! Schedules two TaskServers to start at the same time.
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Field Description

Perform Configuration 
Check

Examines the setup of the TaskServer for 
possible configuration errors. 

Perform Overnight/
Update Check

Runs a test while the TaskServers are in 
Debug Mode by simulating a nightly upload/
download process. Errors are reported to a 
log file, which you can view in the Log Viewer. 
After executing the test the SASIxp software 
displays the following messages:

While the test is running you
will be unable to make enrollment
changes at the district. Proceed
with test?

This test may take several
minutes for the TaskServer to
run. Please wait.

Display Upload/
Download and 
Overnight Start Times

Displays and sorts contents of the ACAM file 
by upload start time. Displays how the nightly 
process runs.

Execute Starts the processes you select.

Campus Number Information comes from the ACAM file.

Campus Name Information comes from the ACAM file.

School Number Information comes from the ACAM file.

TaskServer Information comes from the ACAM file.

Upload Time Information comes from the ACAM file.

Upload Year Information comes from the ACAM file.

Upload All Information comes from the ACAM file.
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Check TRN Tab

Use the Check TRN Tab when the ATRN file is deleted, becomes 
corrupted, or becomes to large. Fix the ATRN by selecting to recreate the 
ATRN file from the District ASTU mirror files, or to synchronize the ATRN 
file with the District ADST files. Click Fix ATRN, to begin the correction 
process.

Check TRN Fields

Field Description

Recreate ATRN from 
ASTU mirror files

Recreates the ATRN file from the District 
ASTU mirror files.

Synch ATRN with 
ADST

Trims the size of the ATRN file by removing 
students no longer in the District.



Copyright © 2005 Pearson School Systems  39

District Consolidation

District Consolidation enables districts to combine data from one or more 
schools into a single database. The District uses these combined files to 
view and produce reports on the consolidated data. For example, this 
feature enables the district to consolidate all of the SASIxp health records 
from your school sites into a district-wide health file. The primary goals of 
district consolidation are:

! Consolidate multiple school data into a single database.
! Consolidate student information into a single database for students 

concurrently enrolled in multiple schools.

This District file has a special naming convention to designate the file as a 
district consolidation file.

The District Consolidation process also creates an enrollment trace file 
(ATRC), which contains the schools each student enrolls in. The SASIxp 
software also creates an error log (DCERR), which contains the 
consolidation processing errors. 
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Setting Up District Consolidation
Define one or more district consolidation file, which specifies the files to 
included in the consolidation. Consolidate each file using one of these 
consolidation methods:

Define one or more district consolidation definitions to specify the schools’ 
data to include in each consolidation. Include each schools’ references as 
a file definition. Schedule the consolidations to run, or run specific 
consolidations manually.

Method Description

Home School Data Only This method applies to student-related files 
only. The method indicates only those 
records from the student’s home school to 
include. Examples files are ASTU, APRN, 
AEMG, and AMED, which would only 
consolidate Home School Data, because the 
home school owns the student’s most current 
information for these files.

All Schools Data This method applies to non-student-related 
files. The method indicates not to apply logic 
when consolidating the files with this method. 
The resulting consolidation simply will be a 
merge of all schools’ files. Configure this 
method for the following files:

! ACRS
! AMST
! ATCH
! ASTF

Home and Concurrent 
Data

Use this method for student-related files 
when the data to consolidate is from the 
home school and all concurrent schools. Use 
the Schedule viewer atom to view student 
schedules.

Exclude Use this non-method to bypass a file setup in 
the CFD type. This option is a convenient 
way to temporarily turn off files you select 
without removing them from the definition.
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Using the Consolidation File Definition Atom
Use the Consolidation File Definition atom to create CFD types. A CFD 
type identifies the files to aggregate during the SASIxp district data 
consolidation process.

For each data file in a CFD type, indicate whether to consolidate data from 
the following options:

! From a student's home school only.
! From home and concurrent schools.
! For all schools attended by the student. 
! Exclude a file to ensure the data is not in the consolidation data file.

The following lists of files are only examples of the files you can include.

For an elementary school, you may include the following files: 

! ASTU – Student
! AENR – Enrollment
! APRN – Parent/Guardian

For a high school, you may want to include the following files: 

! ASTU – Student
! AENR – Enrollment
! APRN – Parent/Guardian
! ACLS – Class Schedule
! ACHS – Course History

Files Supported for Consolidation

Do not include the AATP – Period Attendance or AATD – Daily Attendance 
files in your CFD Types. Data in these files are stored in a manner that is 
not compatible with the data in the other files. To view or report on 
attendance data at multiple schools, use the Attendance Aggregation atom 
to prepare a consolidated data file.

User Files

To get user files for consolidation, you must modify the file through the File 
Definition Pro atom. 

Note: You can choose additional files as needed.
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Modifying User Files for Consolidation

1. Select the user file and open the definition. 

2. Click Keys. 

3. After you are looking at the keys, select the Aggreg1 field in the matrix 
for the first field in the primary key.

4. Select D - Only in District Aggregate Key, for this field.

5. Click Save.

6. Now you can select your user-defined files for consolidation.

Consolidated File Definition Screen

Consolidated File Definition Fields

Field Description

Consolidated File 
Definition Type

File definition descriptions from the CFD 
table of the Tables file (ATBL). Select one of 
the pre-defined values in this field.
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CFD Data File Matrix List of files associated with a CFD Type. You 
can sort the matrix on the file code, file 
description, or consolidation method by 
double-clicking on the appropriate column 
heading.

File Code Four-character code the SASIxp software 
uses to identify the data file. Locate the file 
code in the ACFD File_Code field.

File Description Description of the file code. The data in this 
column is read-only.

Method Consolidation methods:

! Home School Data Only method 
consolidates data from a student's home 
school for the data files you select. This 
option is the default method when adding 
new data files. Use this method for most 
student data files.

! All Schools Data method consolidates 
data from all schools for the data files you 
select. Use this method for non-student 
data files such as MST – Master 
Schedule file, CRS – Course file, or TCH 
– Teacher file. 

! Home & Concurrent Data method 
consolidates data from all schools a 
student is currently enrolled in for the 
data file you select. Use this method only 
for the class schedule file (ACLS).

! Exclude method specifically excludes the 
data file you select from the consolidation 
process. When temporarily changing the 
consolidation status, mark a series of files 
as Exclude, instead of deleting them from 
a CFD Type.

Field Description
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AATG Extract Absence Types Screen

AATG Extract Absence Types Fields

Field Description

Consolidated File 
Definition Type

File definition description from the CFD table 
of the Tables file (ATBL). Select one of the 
pre-defined values in this field.

Absence Types Absence types to extract to the AATG file.

Aggregate All-day 
Absences

Aggregating daily absence codes. Select this 
option to set the system to aggregate Daily 
absences, Half Day absences, and All Day 
Codes from the period attendance files.
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Working With CFD Types

Adding Data Files to a CFD Type

1. Open the Consolidation File Definition atom.

2. In the Consolidated File Definition Type field, select the CFD Type to 
add data files.

3. From the Data pull-down menu, select Add File.

4. In the File Code column, select the data file to add to the CFD Type.

5. In the Method column, select the consolidation method for each data 
file.

6. Repeat Steps 3 through 5 to add additional data files to the CFD Type.

7. Click Save. 

Aggregate Period 
Absences

Aggregating period absence codes. Select 
this option to set the system to aggregate 
Period absences from the period attendance 
files.

Select one checkbox to limit the aggregation 
to Daily absences, Period absences, or 
select both to aggregate all absences. 

Note: You must select at least one checkbox 
for the aggregation process to function.

Field Description

Note: Use the Select Files Fast Access atom to open the Generic 
Selection atom. Select and add multiple data files. The Generic 
Selection atom displays all of the data files in the SASIxp software, 
not just District consolidation files.
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Copying Data Files From One CFD Type to Another

1. Open the Consolidation File Definition atom.

2. In the Consolidated File Definition Type field, select the CFD Type to 
copy data files.

3. From the CFD pull-down menu, select Copy CFD Type.

4. In the Copy CFD Type window, select an existing CFD Type or type a 
three-character code for a new CFD Type in the Table Code field.

5. Click Copy.

Creating District Consolidation Definitions
Use the District Consolidation Definition atom to create consolidation 
definitions that identify the schools to consolidate. The SASIxp software 
uses these definitions to identify how to consolidate school information. 

Note: Each definition includes a group of schools and enables you to 
consolidate data for that group at the district. 

Note: An example is having one definition for the high schools in the 
district, one for the middle schools, and one consolidation file for all 
schools in the district.

Note: The system copies all data files from the first CFD Type to 
the second type. If the second CFD Type has data files, the files 
append to the data file matrix.

Note: Most districts will have only one district consolidation definition, 
D01. But, if dividing schools into different consolidated data files, it is 
necessary to have multiple district consolidation definitions.
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District Consolidation Definition Screen

District Consolidation Definition Fields

Field Description

District Consolidation 
Definitions

Description of the district consolidation 
definition.

Disable Indicates whether to disable the 
consolidation definition.

School Matrix List of schools associated with the 
consolidation definition. To sort the matrix by 
school number, school name, or CFD type, 
double-click the column heading.

Sch# Three-character code for the school.

School Name Name of the school. The data in this column 
is read-only.

CFD Type CFD type to use when consolidating the 
school. The CFD type identifies which data 
file set to use.

Exclude Temporarily excludes the school from 
consolidation.
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Working with Consolidation Definitions

Creating District Consolidation Definitions

1. Open the District Consolidation Definition atom.

2. From the Consolidation Def. pull-down menu, select Add Consolidation 
Def.

3. In the Consolidation Definition window, enter the 3-character code for 
the consolidation definition in the Cons. Code field.

4. In the Cons. Description field, enter a description for the consolidation 
definition. Make this description unique and informative, because only 
the description displays on the District Consolidation Definition screen.

5. Click Add.

Adding Schools to the District Consolidation Definitions

1. Open the District Consolidation Definition atom.

2. In the District Consolidation Definition window, select the consolidation 
definition to add schools using the District Consolidation Definitions 
field.

3. From the Data pull-down menu, select Add School.

4. In the Sch# column, select the school to add to the consolidation 
definition. The system displays the school name in the School Name 
field.

5. In the CFD Type field, select the CFD type. The CFD type identifies the 
data file set to use when consolidating this school.

6. In the Exclude field, select to temporarily exclude this school from 
processing by clicking the cell for each school until the cell displays, 
Yes.

7. Repeat Steps 3 through 5 to add additional schools to the 
consolidation definition. 

8. Click Save.
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Using the District Consolidation Atom
Use the District Consolidation atom to consolidate the data from multiple 
schools in your District. Use the Query atom to view and report on the 
combined data. Use the Schedule Viewer atom to view a student's 
schedule that spans multiple schools in the district.

The consolidation process uses the parameters from the Consolidation 
File Definition and District Consolidation Definition atoms when combining 
the data. 

During the consolidation process, the SASIxp software reads records from 
both the district file (ADST) and the concurrent transaction file (ATRN). 
The resulting data files contain data from all schools in the District 
Consolidation Definition.

The output from the District Consolidation process is a part of SASIxp data 
files on the District server, which contains the consolidated data from the 
SASIxp school sites. The consolidated files have the same file layout as 
the site files. Use the Query atom or a third-party tool to prepare reports on 
the consolidated data.

District Consolidation Screen
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District Consolidation Sets Fields

District Consolidation Progress Fields

The status of the consolidation process. The system fills in the columns of 
the matrix as each file processes. 

Creating Consolidated Data Files

1. Open the District Consolidation atom. 

2. In the Process column of the Consolidation Sets matrix, select the 
district consolidation schools to process. Select the schools by clicking 
the cell until the cell displays, Yes.

3. Select the Obey Filters checkbox to use the filters in the System Filter 
folder to limit the resulting data file.

4. Click Consolidate. 

Field Description

# Set identifier. 

District Consolidation 
Definition Name

Name of the set.

Process Indicates processes of the set.

Obey Filters Indicates use of filters in the System Filter 
folder when consolidating the files.

Field Description

File Four-character code the SASIxp software 
uses to identify the file.

File Name Name of the file.

Status Indicates if the file was processed.

Note: Selecting this checkbox slows the consolidation process. 
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5. Click Continue to consolidate the files, or click Cancel to stop 
consolidation. 

The system reads District and Concurrent Enrollment Transaction files, 
and populates the Consolidation Progress matrix with the names of the 
files from the first school. As each file consolidates, the system displays a 
Completed message. The number of records processed displays in the 
Status column. When the system finishes processing the first school, it 
begins the next school in the District Consolidation Definition.

After finishing the consolidation, the system displays a Completed 
message in the Message Center.

Automating District Consolidation

Use the TaskServer to open a stand-alone application, Autocons.exe, 
which performs district consolidation as part of the nightly TaskServer 
processes. 

After automating consolidation, the system produces a log file, 
Autocon.log. This file contains details about the Auto-consolidation 
process. The log file saves to the Datafile folder.

1. Set up District Consolidation using the Consolidation File Definition 
and District Consolidation Definition atoms.

2. Verify all consolidating schools have valid school calendars.

3. Using the District Consolidation atom, perform a manual consolidation 
to verify the process works properly and contains necessary data. 
Modify until everything is accurate.

4. Use the District Consolidation Definition (DCD) atom to disable any 
consolidation definitions to exclude from the automated consolidation.

Note: If student is not in the District file, they will not be in the 
consolidation file.

Note: Run District Consolidation within the SASIxp software by 
logging into the first school in the DCD definition. If the 
consolidation works properly, the auto-consolidation process works.

Note: By default all DCD are processed.
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5. Modify the TASKSERV.ini file to open the Autocons.exe application. In 
the [UpdateSomeFile] section, change the Name parameter to 
Autocons.exe.

Using the Schedule Viewer Atom
Use the Schedule Viewer atom to view a student schedule that spans 
multiple schools. The schedule includes classes from the home school 
and any concurrent schools the student is currently enrolled in.

This atom works with the consolidated school data files. The District server 
stores the data.

Qualified Files

! ASTU
! ADST
! ACLS
! AMST

Note: The Auto-consolidate for Windows has no window. For 
Macintosh, the Auto-consolidate application displays status 
information.
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! AROT
! AATO
! AACT
! ASCH
! ATRC
! AATC

Schedule Viewer Fields

Field Description

Last Name Student's last name.

First Name Student's first name.

Middle Name Student's middle name.

Grd Student's grade.

Gen Student's gender.

Student ID Student's identification number.

Ln Line number in the matrix.

Sec ID Section number.

Beg Beginning period of the course.

End Ending period of the course.

Trm Term of the course.

Days Day the course meets.

Crs ID Course number.

Course Title Course title.

School School short name.

Tch Teacher number.

Teacher Name Teacher name
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Viewing Student Schedules

Note: Before viewing student schedules from the District server, have 
your District Integration Administrator verify the SASIxp.ini file points to 
the consolidated data file from the setup checklist. 

1. Select the consolidation school to work with by double-clicking the 
Status Bar. 

2. Select the District school from the Change School/Year window.

3. Click Save.

4. Click Close.

5. Open the Schedule Viewer atom.

6. Select the student record to use from the Schedule Viewer window. 
The system displays the schedule for the student you select.

7. When you finish viewing the schedule, click Close.

Printing Student Schedules

Note: Before printing student schedules on the District server, update the 
SASIXP.ini file to point to the consolidated datafile. 

1. Display the student schedule to print.

2. From the File pull-down menu, select Print.

3. In the Print Selection window, select A window in the Format As field, 
and click OK. The system prints the Schedule Viewer window for the 
student.

Using Enrollment Restriction
Use the Enrollment Restriction atom to restrict students from enrolling in 
specific schools in the district, or to limit enrollment to one authorized 
school. Use this atom for District Consolidation.

Restrict student enrollment for reasons such as expulsion, discipline, or 
lack of tuition payment. 

Indicate an Exclusion School, which is the school the student was enrolled 
in at the time of the exclusion. This data is informational and has no effect 
on the enrollment process. It is possible to designate the Authorized 
School as the only school students can enroll in. 
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If a student has an enrollment restriction and you do not select an 
Authorized School to enroll them, the student is not able to enroll in any 
school.

Setting Up Enrollment Restriction

Note: Set up the enrollment restriction reasons using the District 
Consolidation School on the District server.

1. Use the Tables Definition atom to set up the enrollment restriction 
reasons for your schools in the REN table. The REN table contains 
one default entry: TR for Truancy. Create the District REN values in 
School 000 on the District server. 

2. Use the School atom to define the Infraction School list and the 
Authorized Enrollment School list.

3. Enrollment restrictions take effect only if you select the Using 
Enrollment Restrictions option on the Enrollment Options tab of the 
District Control atom.

When selecting the Using Enrollment Restrictions checkbox, the title 
bar of the Enrollment Restriction atom displays Enrollment Restriction. 
If not using the Using Enrollment Restrictions checkbox, the title bar of 
the Enrollment Restriction atom displays Enrollment Restriction 
(disabled).

Enrollment Processing

To support enrollment restriction, the Enrollment atom checks for 
restrictions on students. The SASIxp software processes enrollments if:

! No restrictions are entered for a student and you disable enrollment 
restriction in the District Control atom.

! You enter restrictions for a student, but you disable enrollment 
restriction in the District Control atom.

Note: When making changes to the Using Enrollment Restrictions 
checkbox in the District Control atom, exit and restart the 
TaskServer. This process enables the SASIxp software to 
recognize the changes and enforces the enrollment restriction 
when students transfer or are enrolled. 
When Using Restrictions is on and student does not have 
restrictions, all sites are eligible.
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! You enter restrictions for a student, and you enable enrollment 
restriction in the District Control atom while you are also enrolling the 
student in the Authorized School.

! The SASIxp software displays error messages if all of the following are 
true:

! Entering restrictions for a student.
! Enabling enrollment restriction in the District Control atom.
! The student does not have an Authorized School, or you are 

attempting to enroll the student in an unauthorized school.

Enrollment Restriction Screen
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Enrollment Restriction Fields

If the Student is inactive, a no-show, or if you left out data files in the CFD 
type of consolidation, these fields may be blank.

Field Description

Current Enrollment 
School

School the student is currently enrolled in. 

Note: If the student is currently enrolled in 
a school and you enter an 
enrollment restriction before 
inactivating the student, they could 
be enrolled in an unauthorized 
school.

Enter Date Enter date for the school the student is 
currently enrolled in. 

Enter Code Enter code for the school the student is 
currently enrolled in.

Enrollment Restriction 
Yes

Student has an enrollment restriction.

Exclusion Date Date an enrollment restriction was entered 
for the student. When selecting the 
Enrollment Restriction Yes checkbox, the 
field defaults to the current date. However, 
the Exclusion Date field is not modified 
from the previously entered date.

Exclusion Code Code for the reason the student's 
enrollment is restricted. When selecting 
the Enrollment Restriction Yes checkbox, 
the field defaults to a code of TR, Truancy. 

Clarification Additional information about the 
restriction.

Exclusion School School where the student was enrolled at 
the time of the exclusion.

Authorize enrollment at Only school in which the student can 
enroll.
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Working with Enrollment Restrictions

Adding Enrollment Restriction

1. Open the Enrollment Restriction atom.

2. Select the student record.

3. Click the Yes option for Enrollment Restriction. The system enters the 
current date into the Exclusion Date field. 

4. In the Exclusion Code field, select an enrollment restriction reason 
code. The system displays the description.

5. In the Clarification field, enter additional information about the 
enrollment restriction.

6. To indicate the school the student was enrolled in at the time of the 
exclusion, select the school in the Exclusion School field.

7. To limit students from enrolling in a specific school, select the school in 
the Authorize enrollment at field. 

8. Click Save.

Removing Enrollment Restrictions

1. Open the Enrollment Restriction atom.

2. In the Enrollment Restriction window, select the student’s record.

3. Click the Enrollment Restriction Yes checkbox to deselect it.

4. Click Save.

Note: You can manually change this date if necessary.

Note: If a student has an enrollment restriction and you do not 
select an authorized school, the student is not permitted to enroll.
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Using the Attendance Aggregation Atom
Use the Attendance Aggregation atom to collect student absence data 
from schools in the district. This atom enables you to select one or more 
schools, and one or more absence types. Based on these criteria, the 
atom reads the data files for the schools you select and extracts the 
student absence data.

This data is in the AATG file, and you can query it for District reporting. The 
file contains one record for each student per All Day absence. The data 
differs slightly between period attendance schools and daily attendance 
schools, and for schools tracking half-day attendance.

The SASIxp software only gathers data from the Home school.

The AATG file contains this information for each record:

! Status
! School Number
! Student District Link Number
! Permanent Student Number
! Absence Date 

For period or daily attendance schools, the file also contains the following:

! All Day Absence Code
! All Day Title
! All Day Abbreviation
! Absence Type
! Absence Description

For half-day attendance schools, these fields contain data for a.m. 
attendance. The SASIxp software creates a second set of fields, ending 
with a 2, to hold p.m. attendance data.

When to Use Attendance Aggregation

Run the attendance aggregation process at the District after completing 
overnight processing for the end date to use for any reports. An example is 
when preparing a report on attendance data up to and including the month 

Note: These fields are blank when using class attendance. 

Note: These fields are blank if using class attendance.
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of January. Run attendance aggregation after overnight processing for all 
school sites is complete for January 31. The data in the resulting file is for 
the current year, beginning with the first day of school, ending January 31.

Attendance Aggregation Screen

Attendance Aggregation Fields

Field Description

School # Number of the school to include in the 
aggregation.

School Name Name of the school to include in the 
aggregation.

Absence Types Absence types to include in the aggregation. 
You can select one or more absence types by 
holding down the shift key and selecting the 
types you want.

Note: The Positive absence type captures 
attendance information for all students.
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Aggregating Absence Data

1. Open the Attendance Aggregation atom.

2. Click the Select Schools for Attendance Aggregation Fast Access 
atom.

3. In the Select Schools window, select the schools to collect attendance 
data. 

4. Click Done to return to the Attendance Aggregation window.

5. In the Absence Types matrix, select the absence types to include. 

6. Select to aggregate all-day absences, aggregate period absences, or 
both.

7. Click OK.

The system displays a progress bar in the Message Center. When the 
progress bar disappears, the aggregation is complete.

Aggregate All-day 
Absences

Select this option to enable the system to 
aggregate Daily, Half Day absences, and the 
All Day Code from the Period attendance 
files.

Aggregate Period 
Attendance

Select this option to enable the system to 
include the period absences from the period 
attendance files.

Field Description
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This section provides additional information to assist in the troubleshooting 
of TaskServer program operational errors.

The SASIxp software maintains TaskServer operational status information 
in three log files at the District Site. These three files are AUFS, AONL, 
and ATEL. 

School Site client workstations update a local school site log data file for 
District Integration enrollment operations (ATLL).

Using the Query atom, you can interrogate these log files.

These log files are cumulative and can grow to be extremely large. 
Periodically you must manually delete some of these files to improve 
performance. Deleting these files ensures they do not consume a large 
amount of disk space on the school and district site file servers.
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Troubleshooting the Upload Process
During the upload process, the DI TaskServers maintain a log of upload 
transaction status messages in the Upload File Status file (AUFS). The 
following table provides information on the messages in the AUFS file. 

The Level Type key equivalents are:

! F=Failure
! W=Warning
! S=Success

Level 
Type Code

Message 
Description Possible Reasons

F 11 Error copying the 
file

! Not enough space on the District 
file server

! Not enough privileges to see 
directories or copy files from the 
site file server

! Hard disk corruption
! Network connection problems

F 21 Volume cannot 
be mounted

Cannot map 
drive to the 
volume

! Invalid user ID or password
! User ID does not have connect 

authority
! School network does not permit 

connections after a specific time
! Password encryption at school 

server

F 31 Wrong server 
type

Windows TaskServer tried to upload 
from an AppleShare site file server

F 51 Internal error Unknown; note the IntCode field 
and call Pearson School Systems 
Support

F 52 Internal error Unknown; note the IntCode field 
and call Pearson School Systems 
Support

F 58 User abort User aborted the Upload process 
from the TaskServer
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F 59 Error Detected One of the above errors was 
detected

W 61 Cannot set time 
stamp for 
successfully 
uploaded file

Internal error; call Pearson School 
Systems Support

W 62 Cannot un-
mount volume

Cannot 
disconnect 
volume

! The current drive is in use for 
another process

! The system is not connected to 
the current drive

W 63 Warnings during 
upload

One of the above warnings was 
issued

S 71 File copied 
successfully 

Status message

S 81 Begin uploading 
one school

Status message

S 89 End uploading 
one school

Status message

S 91 Begin upload 
process

Status message

S 92 End upload 
process

Status message

Level 
Type Code

Message 
Description Possible Reasons
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Troubleshooting the Download Process
During the download process, the DI TaskServers maintain a log of 
download transaction status messages in the Download File Status file 
(ADFS). The following table provides information on the messages in the 
ADFS file. 

The Level Type key equivalents are:

! F=Failure
! W=Warning
! S=Success

Level 
Type Code

Message 
Description Possible Reasons

F 11 Error copying the 
file

! Not enough space on the district 
file server

! Not enough privileges to see 
directories or copy files from the 
site file server

! Hard disk corruption
! Network connection problems

F 21 Volume cannot 
be mounted

Cannot map 
drive to the 
volume

! Invalid user ID or password
! User ID does not have connect 

authority
! School network does not permit 

connections after a specific time
! Password encryption at school 

server

F 51 Internal error Unknown; note the IntCode field 
and call Pearson School Systems 
Support

F 52 Internal error Unknown; note the IntCode field 
and call Pearson School Systems 
Support

F 58 User abort User aborted the Download process 
from the TaskServer
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F 59 Error Detected One of the above errors was 
detected

W 61 Cannot set time 
stamp for 
successfully 
downloaded file

Internal error; call Pearson School 
Systems Support

W 62 Cannot un-
mount volume

Cannot 
disconnect 
volume

! The current drive is in use for 
another process

! The system is not connected to 
the current drive

W 63 Warnings during 
download

One of the above warnings was 
issued

S 71 File copied 
successfully 

Status message

S 81 Begin 
downloading one 
school

Status message

S 89 End 
downloading one 
school

Status message

S 91 Begin download 
process

Status message

S 99 End download 
process

Status message

Level 
Type Code

Message 
Description Possible Reasons
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Troubleshooting the Overnight Process
The TaskServer uses the Overnight Log file (AONL) to record Overnight 
transaction status messages. Some of the errors in the AONL file may also 
indicate problems with the Upload process. Query the AUFS and AONL 
files to identify all errors.

The Level Type key equivalents are:

! F=Failure
! W=Warning
! S=Success

Level 
Type Code

Message 
Description Possible Reasons

F 21 Cannot create TEMP 
directory in the 
SASIXP/DATAFILE 
directory

! Not enough space on the 
District file server

! Problems with the hard 
drive

F 31 Cannot move file 
from dump directory 
to the SASIXP/
DATAFILE directory

! SASIxp software is running 
on the District file server

! Problems with the hard 
drive

F 32 Error during 
uploading this school. 
Data will not be 
moved from dump 
directories to the 
SASIXP/DATAFILE 
directory

Error during the Upload process 
- query the AUFS file to 
determine the upload error

F 58 User abort User aborted the process from 
the TaskServer

F 59 Error detected during 
overnight process

One of the above errors 
occurred during the Overnight 
process
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Analyzing the ATEL File
When generating the real-time transactions add, inactivate, transfer, 
delete, or no-show, the SASIxp software performs several mini-
transactions. The SASIxp software records these mini-transactions in the 
ATEL file.

The fields in the ATEL file and their possible contents are:

S 71 Moved one file 
successfully from the 
dump directories to 
the SASIXP/
DATAFILE directory

S 81 Begin moving files for 
one school

S 89 End moving files for 
one school

S 91 Begin overnight 
process

S 99 End overnight 
process

Level 
Type Code

Message 
Description Possible Reasons

Field Description

School Number School number the student is enrolled in or 
dropped from.

User ID User ID of the enrollment clerk at the school 
site where the enrollment transaction takes 
place.

Log Number Consecutive number assigned to each record 
in the log file. When the TaskServer is re-
started, this number resets to zero.
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Command Transaction Messages

TaskServer Number the TaskServer creates for the 
record. Each TaskServer assigns a number in 
the [PollPC] section of the SASIXP.ini file.

Trans Date Date of the transaction.

Trans Time Time of the transaction.

Command A number identifying the transaction.

See Command Transaction Messages on 
page 70.

Level Error identified by the TaskServer. 

See Level Error Messages on page 72.

Error Error identified by the database or operating 
system. 

Permanent Number Student’s permanent ID number.

Field Description

Number Displayed Message Description

1 TSK_GET_TASK_SERVER_INFO School atom confirms 
Centralized District 
Processing.

2 TSK_GET_N_STUDENTS_GIVEN_NAME Enrollment atom gets list 
of student names to find.

3 TSK_GET_N_STUDENTS_GIVEN_ID Enrollment atom gets list 
of students.

4 TSK_GET_STUDENT_RECORD_GIVEN_ID  Enrollment Atom gets 
student record to show 
prior to save.

5 TSK_ADD_STU_DST_RECORD_GIVEN_NAME   Enrollment Atom adds 
student to District and 
site, and gets perm ID.
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6 TSK_ACTIVATE_STU_DST_RECORD_GIVEN_ID Enrollment Atom 
transfers or re-activates 
a student.

7 TSK_INACTIVATE_STU_DST_RECORD_GIVEN_ID  Enrollment Atom 
inactivates a student.

8 TSK_DELETE_STU_DST_RECORD_GIVEN_ID   Enrollment Atom deletes 
a student.

9 TSK_GET_LIST_OF_SUB_FILES Enrollment Atom needs 
list when transferring or 
dropping a student.

10 TSK_GET_SUB_RECORDS_GIVEN_ID_AND_SUB   Enrollment Atom gets 
one sub-file at a time, 
when transferring.

11 TSK_GET_STU_PICTURE_GIVEN_ID Enrollment Atom 
retrieves the photo to 
show prior to saving.

12 TSK_WRITE_STU_PICTURE_GIVEN_ID Enrollment Atom sends 
the photo to the archive 
file when inactivating a 
student.

13 TSK_WRITE_SUB_RECORDS_GIVEN_ID_AND_SUB  Enrollment Atom sends 
one sub-file at a time, 
when inactivating.

14 TSK_NOSHOW_STU_DST_RECORD_GIVEN_ID   Enrollment atom No-
Shows a student.

Number Displayed Message Description
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Level Error Messages

Number Displayed Message Description

1 TSK_NO_ MEMORY The TaskServer does not have 
enough memory. On a Macintosh, 
use Get Info to increase the 
TaskServer’s memory. On 
Windows, acquire more memory.

2 TSK_CANT_GET_DST_RECS Error retrieving a list of students.

3 TSK_CANT_FIND_ONE_DST_REC  Cannot open a sub-file, or cannot 
get the student’s district record 
using the Perm ID. 

4 TSK_INVALID_MIRROR_SCHOOL Due to an error in the ADST file, 
cannot determine the student’s 
mirror school.

5 TSK_INVALID_MIRROR_STU_LINK  Due to an error in the ADST file, 
cannot determine the student’s 
mirror StuLink.

6 TSK_CANT_FIND_ONE_STU_RE Cannot find the student in the 
mirror ASTU file using the Perm 
ID.

7 TSK_CANT_OPEN_STU_MIRROR Cannot open the mirror ASTU file.

8 TSK_CANT_UPDATE_STU_REC Cannot update the student record 
in the mirror ASTU file.

9 TSK_CANT_DELETE_STU_REC Cannot delete the student record 
in the mirror ASTU file.

10 TSK_CANT_DELETE_DST_REC Cannot update the student record 
in the ADST file.

11 TSK_CANT_OPEN_STU_PICT Cannot create the photo file when 
inactivating the student.

12 TSK_CANT_READ_STU_PICT Error reading the photo file when 
transferring a student.
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13 Invalid subfile (lacks StuLink or SchNum field) 
in list.

No StuLink or SchNum found 
during the transfer of subfiles in 
the enrollment process.

14 TSK_XMIT_CPY_ERROR Not used.

15 TSK_CANT_CREATE_FILE Not used.

16 TSK_CANT_WRITE_TO_FILE Not used.

17 TSK_CANT_READ_FROM_FILE Not used.

18 TSK_CANT_WRITE_STU_PICT Not used.

19 TSK_TASK_SERVER_ERROR Not used.

20 TSK_CANT_GET_SUB_LIST Not used.

21 TSK_CANT_FIND_SCHOOL_REC Cannot get the school record in 
the ASCH file.

22 TSK_NO_SUB_FILES No sub-files were entered in the 
District Control atom.

23 TSK_CANT_ADD_STU_REC Not used.

24 TSK_TRN_SCH_SAME_AS_MIRROR_SCH Attempting to transfer or reactivate 
a student in a school, and the 
student record in the ASDT file 
shows the student is already active 
in that school.

25 TSK_FILE_INFO_ERROR Not used.

26 TSK_KEY_INFO_ERROR Not used.

27 TSK_CANT_UPDATE_SUB_FILE When inactivating or no-showing a 
student, cannot update records in 
the mirror sub-file.

28 TSK_CANT_DELETE_SUB When inactivating or no-showing a 
student, cannot delete records in 
the mirror sub-file. 

Number Displayed Message Description
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29 TSK_CANT_OPEN_SUB Cannot open a mirror sub-file, or 
the data sent from the site is 
invalid. 

30 TSK_CANT_LOCK_DCL_FOR_NEXT_ID Not used.

31 TSK_CANT_UPDATE_DCL_FOR_NEXT_ID Error trying to get the next Perm 
ID from the ADCL file when 
adding a new student to the 
District.

32 TSK_CANT_READ_DCL_FOR_NEXT_ID  Error trying to get the next Perm 
ID when adding a new student to 
the District.

33 TSK_CANT_ADD_STUDENT_TO_MIRROR  Cannot add the student to the 
mirror ASTU file.

34 TSK_CANT_ADD_STUDENT_TO_DST  Cannot add the student to the 
ASDT file. Reorganize the ADST 
file if this error persists.

35 TSK_CANT_GET_NEXT_STU_LINK  Not used.

36 Unable to get student (ASTU) record from 
mirror file

The TaskServer is not 
communicating with the District 
office.

37 Unable to activate student at the district office The TaskServer is not 
communicating with the District 
office.

38 Unable to inactivate student at the district office The TaskServer is not 
communicating with the District 
office.

39 Unable to delete student at the district office The TaskServer is not 
communicating with the District 
office.

40 Unable to add student at the district office The TaskServer is not 
communicating with the District 
office.

Number Displayed Message Description
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41 TSK_CANT_GET_NEXT_DST_LINK The next District Link cannot be 
retrieved from the ASCU file. 
Make sure the Next ID Atom has 
an entry greater than zero for 
ASDT, DST_LINK.

42 TSK_UNABLE_TO_UPDATE_TRN Cannot update the ATRN file. The 
SASIxp software only uses the 
ATRN file when students are 
concurrently enrolled in two or 
more schools.

43 TSK_UNABLE_TO_ADD_TRN Cannot add to the ATRN file. The 
SASIxp software only uses the 
ATRN file when students are 
concurrently enrolled in two or 
more schools.

44 TSK_NO_ACTIVE_TRN_RECORD_FOUND Attempting to delete, inactivate, or 
no-show a student from one of the 
concurrently enrolled schools, and 
there is no record of the student in 
the ATRN file.

45 TSK_CANT_OPEN_ENR_MIRROR Cannot open the AENR file.

46 TSK_UNABLE_TO_NOSHOW_ONE_STU_TS Not used.

47 TSK_CANT_OPEN_LAST_STU_MIRROR   When undoing a transfer, the 
ASTU file for the student’s 
previous school cannot be 
opened.

48 TSK_CANT_UPDATE_DST_REC Cannot update the student’s 
record in the ADST file with the 
Enrollment code and date or the 
leave code and date.

Number Displayed Message Description
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